
5  NAVIGATING THE DEKO4078SD 
SIGNAL BOOSTER MANAGEMENT TOOL 

This chapter describes how to navigate the Deko4078SD signal booster Management 
Tool application and the available functions.  

5.1 ACCESS LEVELS  
The enabled parameters displayed by the application depend on the access mode: 
User or Guest.  

5.2 MAIN WINDOW 
The Main window consists of the following tabs: 

• Settings – enables configuring and defining the signal booster and filter 
parameters in the corresponding tabs.  

• Alarms – Provides summary view of alarms and alarm log 
• Measurements – provides a summary of the configured filter parameters 

and their alarms 
• Administration – Includes the system information, SW upgrade option, 

communication parameters and user management option 

5.3 SETTINGS 
The Settings window consists of three main tabs: General, Filter and Advanced-
Installation. 

5.3.1 GENERAL 
The following figure shows the General tab of the Settings window. 
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There are four main field areas: 

• General – consists of the Mute Band option that enables manually muting 
the supported domains (700DL  800 DL and UL) 

• Isolation Settings – provides the signal booster isolation parameters for 
configuration (Isolation and Back Off Isolation) which also determine the Max 
Gain for all the domains (automatically calculated). 

• Input Window – displays the boosters high and low sensitivity limits for the 
sliding window. The high Input window High limit is configurable where as the 
low limit is adjusted automatically.  

Note: The attack and release time for the sliding window is determined in the 
Advanced-Installation tab (see  5.3.2). 

• Downlink Routing – Includes the Downlink Routing capability options that 
enable defining the number of filters to be used for each 700 and/or 800 MHz 
bands. 

 
  



PRODUCT MANUAL DEKO4078SD MULTI-CHANNEL SIGNAL BOOSTER DEKOLINK WIRELESS LTD. 

Page 32  Proprietary Data P/N 300SC30031 Rev. 1.2 

 

5.3.2 ADVANCED – INSTALLATION 
The following figure shows the Advance-Installation tab of the Settings window. 

 
The Advanced-Installation tab consists of three main field areas: General, Input 
Window and Marker Tone, PL Mode. 
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The following table provides a description of the parameters displayed in the 
Advanced-Installation field areas. 

Field Area Parameter Description 
General In Path Offset (dBm) The attenuation measured (per 

domain – DL700/DL800/UL) between 
the Input antenna to the DMSB 
Signal Booster 

Out Path Offset (dBm) The attenuation measured (per 
domain – DL700/DL800/UL) between 
the output of the DMSB Signal 
Booster to the antenna 

System de attach time (msec) Determines the amount of time the 
channel remains open after the 
transmission has ended 

Power Save (msec) Determines the amount of time 
(msec) after which the filter P.Amp is 
muted if it is not active. 
Note: The mute is immediately 
released once the filter resumes 
being active. 

Input 
Window 

Attack Time (µsec) Attack time for sliding window 

Attack Steps (dB) Attack steps in dB increments for 
Attack time 

Release Time (sec) Release time for sliding window 
Release Steps (dB) Release steps in dB increments for 

Release time 
Marker Tone, 
PL Mode 

Marker Tone Period (msec) Duration (msec) of the CW – signal 
generated by the signal booster for 
the ID Tone 

Marker Tone Frequency (Hz) CW frequency (Hz) for ID Tone 
Marker Tone Volume Volume of CW for ID Tone 
Time Out Timer (sec) Limits channel occupancy to 

configured amount of time 
PL Timer (msec) PL (Private line) timer for closing 

channel when wrong PL detected 
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5.3.3 FILTERS 
There are two filter screens: One provides a summarized description of the 
configured filters and the other provides the user with the filters’ configurable 
parameters. 

5.3.3.1 Filter Parameters  
The following figure shows the Filters (parameters) tab of the Settings window. This 
window is accessed by clicking on the Add/Edit filter button of the Filter 
(700/800) window (see Figure 19).  
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Figure 18. Filter Parameters 

The majority of the parameters are displayed with default values, which can be user 
modified according to customer requirements. This window enables the user to select 
the required filter type and determine the DL center frequency. 

Note: After configuring or modifying a parameter, click Apply to save the definition to the 
signal booster. 
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The following table provides a description of the parameter fields displayed in the 
window above. 

Field Description 
Filter Type Combo box that provides a list of the available 

filter types 
Transmit Enable Enables filter operability. If this option is not 

enable (check marked) the filter will be defined but 
not operable. 

Multiple Channel Enable Option for enabling/disabling (default: enable) 
filter monitoring  

 For Setup – enables RSSI readings even 
when channel is not transmitting 

 For wideband filters – if a wideband filter 
is selected the monitoring option should be 
disabled in order to save power. 

AGC Enable Option for enabling and disabling Automatic Gain 
Control feature 

Frequency (MHz) Center Frequency 
Signal Gate Threshold Level 
low (dBm) 

UL and DL RSSI thresholds (low and high) in the 
Signal Gate Threshold fields determine the 
range in which the filter is active Signal Gate Threshold Level 

high (dBm) 
Max Power Level (dBm) This value limits the signal booster maximum 

output power.  
Max Gain Level (dB) This value limits the gain to a maximum of 90dB. 
PL Enable Option for enabling and disabling PL 
PL Frequency (Hz) Enables setting the PL frequency between 67 – 

254 Hz 
ID Tone Provides several options for generating a specific 

tone in order to check the communication during 
setup (see  6.1) 

CW Route Determines the type of signal generated for the ID 
Tone by the signal booster 

 Normal – Signal is passed “as is” 
Zero – No signal 
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5.3.3.2 Filter Description 
The following figure shows the Filters (description) tab of the Settings window. A 
separate window is displayed for each of the 700 and 800 bands. 

This window includes the Add/Edit Filter option and provides a description of the 
type of filter(s) in use, their UL and DL center frequency, output power and gain. 
After the filters have been configured the user can navigate to this screen in order to 
view the filter characteristics (read only screen). 

 

Figure 19. Filter Description 

The following tables provide a description of the fields and buttons displayed in the 
figure above. 

Field Description 
ID Filter ID Number 
Select Checkbox for selecting filter to be edited 
Enable Provides indication on whether the filter is enabled or 

not 
Description Description of  selected  filter type  (see  4.2.3) 
Channel Filter channel number  - translation from frequency to 

channel number 
Center Frequency (MHz) DL/UL center frequency 
Max Out Power (dBm) DL/UL Max composite output power settings 
Max Gain (dB) DL/UL Max gain settings 

                   
Button Description Comments 
Add/Edit Filter Used for adding a new filter or editing an 

existing one 
 

Delete Filter Used for removing a selected filter from the 
list 

 

Previous Used for navigating to previous screen 
(filter parameters screen) of selected filter 
when editing 

It is recommended to 
avoid using the scroll 
bar and use the Next 
and Previous buttons Next Used for navigating to next screen  

 
 

Add/Edit Filter button.
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5.4 ALARMS 
The alarms are displayed in two windows. One provides a summarized view of the 
system alarms and the other provides a log of the alarm history. 

5.4.1 SUMMARY VIEW 
The alarms Summary View tab displays the monitoring alarms for the system 
elements (Main, Power Amplifier and Power Supply) in addition to the Mute (per 
band) and External Alarms. See  6.5 for alarms description. 

 

Figure 20. Alarms Summary View 
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5.4.2 LOGS 
The Alarms Log tab of the CMU window displays a history of up to 200 logs of 
alarms generated by the system. The tab consists of a tabular screen with sorting 
capabilities that include the alarm time stamp and description. 

 

Figure 21. Alarms Log 

5.5 MEASUREMENTS 
The Measurements window is a read-only window which displays a summarized 
view of the configured filters for each band (the filters for the 700 and 800 bands are 
displayed in separate screens). This screen provides the user with a general 
description of the filters in addition to indicating whether the RSSI and Output Power 
threshold levels have been exceeded. 

 
See  5.3.3.2 for description of fields. 
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5.6 ADMINISTRATION 
The Administration window consists of the following tabs: 

• System Information – Displays the system information such as the SW 
version and the system elements’ part numbers. See  6.9 

• Backup – Enables user to backup and restore user parameters such as the 
filter settings. See  7.2.3 

• SW Upgrade – Enables user to upgrade the application SW with latest 
version. See  7.2.2 

• Filter Import – Displays an inventory of all the filter types (grouped in 
banks) and provides a filter management option that enables the user to 
upload new filters to the filter bank. See  7.2.4.  

• Communication – Displays configurable communication and modem 
parameters. See  4.2.4. 

• Users – Provides user management options. See  7.1 

 



6  DMSB MT OPERATIONS 

6.1 FILTERS 
The application enables the user to add, edit and delete filters. See following sections 
for descriptions. 

6.1.1 ADDING A FILTER 
To add a filter 
1.  Click on the Filters tab of the Settings window. The following window appears: 

Note: Upon initial setup there are no filters listed. 

 
2.  Verify that no existing filters are selected and click on the Add/Edit Filter 

button. The following window appears. 

 

 
3.  Select the required filter type in the Filter Type field.  

Note: Filter types are taken from the list of available filter types. 

4.  Define the DL center frequency in the Frequency field. 

5.  Define the RSSI threshold range in the Signal Gate Threshold Low/High 
fields. 

Add/Edit
Filter
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Note: The remaining filter parameters and attributes are displayed with default values 
that can be modified according to site requirements. 

6.  The default filter Max Gain value displayed is the Maximum Gain calculated 
according to the isolation settings (see section  4.2.1 step 2). This value can be 
modified, however the filter Maximum Gain cannot be higher than that calculated 
according to the booster isolation settings. If a higher maximum gain value is 
required the isolation settings must be modified accordingly. 

7.  Click Apply. 

6.1.2 EDITING FILTERS 
To edit a filter 
1.  Click on the Filters tab of the Settings window. The following appears: 

 
2.  In the Select column, select the filter to be edited. 

3.  Click the Add/Edit Filter or Next button. The following window appears: 

 
 

4.  Modify the required parameters and click Apply. The previous filter screen 
appears. 
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6.1.3 DELETING FILTERS 
To delete a configured filter from the list 
1.  Click the Filters tab of the Settings window. The following appears: 

 
2.  In the Select column, select the filter to be deleted. 

3.  Click the Delete Filter button. The filter table will be updated and displayed 
with the new list of available filters. 

6.2 GENERATING ID TONE ON CHANNELS 
The ID tone is used for the “Walk Test” and enables the Deko4078SD signal booster 
to generate a specific tone in order to check the communication during setup. The ID 
Tone option is accessed through the Routing tab of the DDF window. See following 
figure. 

 

ID Tone

Delete Filter 
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To determine the ID Tone 
1.  In the ID Tone field of the Filters (parameters) tab select one of the following 

ID Tone types from the drop down list: 

• Normal – Beep will be sounded at the beginning of the conversation 
• Repetition – Beep will be sounded at predefined intervals 
• Continuous – A continuous beep is sounded. 

Note: Select Disable to disable the function. 

2.  In order to use the Booster as a signal generator, select the Normal option 
(default) from the CW Route drop-down list. 

Note: Select Zero for no signal. 

3.  Click Apply. 

4.  Define the following ID Tone parameters in the Marker Tone field area of the 
Advanced-Installation tab (Settings window): 

• Marker (ID) Tone Period 
• Marker (ID) Tone Frequency (Hz) 
• Marker (ID) Tone Volume 

 
5.  Click the Send Parameters button. 
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6.3 MODIFYING DEKO4078SD PARAMETERS 
To modify the signal booster parameters 
1.  Click the General sub-tab of the Settings tab. The following appears. 

 
2.  Perform the required changes in the displayed parameters (see field descriptions 

in section  5.3.1). 

Note: Upon selecting a different downlink routing option, the previous filter map is 
deleted and a new one must be configured (see  4.2.3 and/or  6.1.1).  

3.  Click Send. 

6.4 VIEWING ONLINE BOOSTER PARAMETERS  
To view current signal booster Parameters 
After a connection has been established between the computer and the signal 
booster click the Refresh button, located at the bottom of the Settings window 
shown below. 
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6.5 MONITORING ALARMS 
The application provides three levels of alarms: 

• System alarms – Provides the monitoring alarms for all three system units: 
Main, Power Amplifier and Power Supply. In addition, includes the Mute 
alarms. 

• External alarms – Provides monitoring according to the external alarms 
defined by the user (see  6.7) 

• Specific alarms per channel – Provides the user with alarms (per filter) 
indicating whether the filter exceeds the configured threshold range. 

The following sections describe the alarms displayed in the application GUI. 

6.5.1 SYSTEM ALARMS AND EXTERNAL ALARMS 
The Summary View tab of the Alarms screen provides a summary view of the 
monitoring alarms for the system elements and the external alarms. 

 

Figure 22. Alarms- Summary View  



PRODUCT MANUAL DEKO4078SD MULTI-CHANNEL SIGNAL BOOSTER DEKOLINK WIRELESS LTD. 

Page 46  Proprietary Data P/N 300SC30031 Rev. 1.2 

The following table provides a description of the alarms displayed in the figure 
above. 

Alarm Group Alarm Description 
Shutdown/Mute Mute Mute per band - can be a result 

either of a manually performed mute, 
system mute or fatal error at the 
initialization phase. 

Service Band PA mutes due to failure to 
transmit power 

Main Drawer Fan Indicates operation status of fan 
Temperature Indicates an inner temperature over 

60ºC. The power supply shutdowns 
the system when the temperature 
reaches 70ºC 

PLL Lock PLL lock per band at Main drawer - 
Faulty status of the Phased Locked 
Loop (PLL) 

RF Input Level Expected RF input level 
Overflow  

Power Supply 
Drawer 

Fan Red – Critical Alarm 
Orange – Warning 
Green - OK 

Temperature Indicates an inner temperature over 
60ºC. The power supply shutdowns 
the system when the temperature 
reaches 70ºC 

VSWR VSWR per band at P.Amp drawer - 
High Voltage Standing Wave Ratio 
(VSWR) at the output port 

P.Amp Current P.Amp Current per band at  P.amp 
drawer 

External 
Alarms: 

Input Ext Shut If the external signal arrives   then 
the system will be  muted and the 
corresponding alarm will be set 

 Ext 2 Generic name that can be user 
defined - If the external signal arrives 
and the event is enabled the 
corresponding Alarm is set  

 Output Ext Major If there is at least one major alarm in 
the system (as a result of system 
mute) the signal will be output and   a 
corresponding Alarm will be set 

 Ext Minor If there is at least one minor  alarm in 
the system (system is not muted) the 
signal will be output and   the 
corresponding alarm will be set 
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6.5.2 SPECIFIC CHANNEL ALARMS 
The alarms for the specific channels are viewed through the Filters tab of the 
Measurements screen. 

An alarm indication is provided for each filter indicating whether they have exceeded 
their defined threshold limits. Alarm indications are provided for the following 
parameters: RSSI (dB), Out Power (dBm) and Gain (dB). 

 
Red – threshold limits have been exceeded 

Green – within threshold limits 
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6.6 VIEWING GRAPHIC DISPLAY OF FILTER  
The Filter screens are shown by selecting a Filter Type in one of the window tabs 
and clicking the corresponding Show button.  

The Filter screen includes several displays (Select Picture button, at bottom) that 
enable viewing the filter properties and characteristics to ensure a proper selection of 
the filter. 

 

6.7 DEFINING THE EXTERNAL ALARMS 
The external alarms can be defined and managed by the GUI application. This is 
performed by an administrator. The application enables the administrator to define 
two input and two output events, to enable/disable the alarms and to determine the 
activation mode (normally open or normally closed. 

To define the external alarms 
1.  Click the External Alarms tab of the Administration window (in Administration 

mode). The following tab appears: 

Show button 

Filter display 
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Figure 23. External Alarms Tab 

2.  Define the Input modes: 

• NC – Normally Closed 
• NO – Normally Open 

3.  Define a name for Input 2 in the Description field (the default is a generic 
name). 

Note 1: The Input 1 description is hardcoded “Ext shut”. 
Note 2: When an external signal is received the system is muted and a 
corresponding alarm is generated. 

4.  Define the Output modes as performed for the Input, above.  

Note: The Output signals are hardcoded as Ext major and Ext Minor. 
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6.8 SLIDING WINDOW CONFIGURATION 
Use the Input Window field area in the Advanced-Installation sub-tab to set the 
acknowledgment delay period (Sliding Window). 

To set the sliding window options 
1.  Click the Settings tab and then click the Advanced-Installation sub-tab. The 

following screen appears. 

 
2.  Define the following parameters: 

• Attack Time (µsec) - Time between the instant the signal exceeds the 

activation threshold and the units’ reaction (default is 10µsec). The Attack Time 

range is between 10-50µsec. In addition, define the Attack Steps (0-31dB). 

• Release Time (sec) - Interval between the time the signal is disabled until it is 
continued (default is 1sec). The Release Time range is between1-60sec. In 
addition, define the Release Steps (0-31dB). 

 3.  Click Send. 

6.9 VIEWING SYSTEM INFORMATION 
Refer to the System Info sub-tab of the Administration tab to view the signal 
booster general information. The following properties are displayed: 

• System SW version 
• Main drawer part number 
• P.Amp drawer part number 
• Power Supply part number 
• UD DL SN – Up-Down Downlink Serial Number 
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• UD UL SN – Up-Down Uplink Serial Number 
• DDF DL SN – Dekolink Digital Filter Downlink Serial Number 
• DDF UL SN – Dekolink Digital Filter Uplink Serial Number 
• Monitor/Main Drawer SN 
• Monitor/P.Amp Drawer SN 

 

 



7  ADMINISTRATION 

7.1 MANAGING USERS 
By default, twelve users belonging to one of three authentication levels are defined 
on the Booster. You may add new users, modify or delete existing users. 

7.1.1 USER LEVELS 
Three user levels are available:  

• Admin – has access to all administration and configuration options, including 
user management. (Default Password admin and default User Name 
admin.) 

• Operator – has access to all configuration options except for the Users list or 
the Loaders screen.  

• Guest - Read-only access. 

7.1.2 VIEWING THE LIST OF DEFINED USERS  
To display the User Administration pane 
From the Tree Pane, select Users. The list of users is displayed in the Configuration 
Pane according to the identifying information and authentication level (Role). 

 
The following table provides a description of the Users dialog buttons and options. 

Management 
Option 

Description 

Add User 
(button) 

Adds a new user with to user defined access level and 
password.  

Del(ete) Deletes the corresponding user from the list. 

Edit  Enables changing the definitions of an existing user. 



PRODUCT MANUAL DEKO4078SD MULTI-CHANNEL SIGNAL BOOSTER DEKOLINK WIRELESS LTD. 
 

P/N 300SC30031 Rev. 1.2 Proprietary Data Page 53 
 

 

7.1.3 ADDING USERS 
NOTE: User name and password entries are case sensitive. 

To add a user:  
1. From the Tree Pane, select Users. The list of users is displayed in the User's 

Pane. 

2. From the User's Pane, click Add User. The Add User dialog box is displayed. 

 
 

3.  Enter the Login Name – name used by user to login. 

4. Type the users First Name and Last Name – used to identify the user.  

5. Select the User Role – access level. This defines the operations that the user 
will be able to perform.  

6. Enter the Password and in Verify Password enter the password again for 
verification. 

7.  Click OK. 

7.1.4 EDITING USERS 
To modify user definitions 
1. From the Tree Pane, select Users. The list of users is displayed in the User's 

Pane. 

2. Select the User to be edited in the list. 

3. Click Edit. The user definitions dialog appears. 

4. Make the required changes and click OK. 

7.1.5 DELETING A USER 
To delete a user:  
1. From the Tree Pane Select Users. The list of users is displayed in the User's 

Pane. 

2. Select the User to be deleted in the list.  
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3. From the User's Pane, click Del. An authorization message dialog box is 
displayed. 

 
4. Click Yes. The User’s name is removed from the list. 

7.2 CONFIGURATION, BACKUP AND RESTORE 
The application enables performing the following backup and restore operations via 
the Backup/Restore dialog: 

• Backing up the current configuration 
• Restoring any previously saved configuration to the booster 
• Restoring the booster’s factory default setup 
• Restoring a configuration file from a user defined location 

NOTE: The configuration backup and restore files are stored in the Deko-CMU.  

This section describes the Backup/Restore dialog and how to perform the backup, 
restore and upload operations. 

7.2.1 THE CONFIGURATION BACKUP WINDOW 
To access the configuration backup window: 

1. From the Tree Pane, select the Booster and click the Backup/Restore button. 

2. The Backup/Restore pane appears. The pane lists the currently backed up files 
and provides backup and restore options.  

The files are listed along with identifying information and the time of the backup. 
Files of user defined configurations are BLUE.  

The default factory settings file is BLACK and is named DEKO4078_System.csv. 

7.2.2 SW UPGRADE 
The SW upgrade procedure must be performed for each individual Booster module: 
UD Uplink; UD Downlink; DDF Uplink; DDF Downlink.  

NOTE: During the upgrade, the Booster is disconnected from the network.  

CAUTION  

DO NOT TURN OFF THE BOOSTER DURING THE UPLOAD PROCESS!!!  

View the current SW version in the System-Info sub-tab of the Administration tab 
(see  6.9). 

To perform the software upgrade procedure 
1. Select the Administration tab SW Upgrade sub-tab. The following window 

appears. 
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2.  Select the module to be upgraded from the Select a Module  drop-down list. 

3. Click Browse to browse for the upgrade file and click Open.  

4. Click Upload. The updating process begins. A message appears in "The activity 
log" box during the upload activity.  

5. Once the updating process ends successfully, a message is issued in "The activity 
log" box. The next process – Getting the version number – is displayed.   

6. Once the software version is ready to be installed (see message in "The activity 
log" box), click Burn to continue. The installation process starts, and is run 
automatically.   

7. Wait until the update is complete (about 10 minutes). If the link is established 
through the modem, the speed of the connection determines how long the 
process takes.  

Once the installation process ends successfully, a message is issued in "The activity 
log" box. 
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7.2.3 CONFIGURATION BACKUP AND RESTORE 
The Backup option enables the user to backup and restore the user parameters. This 
is used mainly for backing up or restoring the filter settings (for all the domains).  

7.2.3.1 Configuration Backup 

To perform the configuration backup 
1. Click the Administration Backup sub-tab. The following Backup screen appears. 

 
The pane lists the currently backed up files and provides backup and restore 
options. 

2. Click Backup. A backup is created (a message is shown) and when completed, a 
new file is added to the list. 

Note: The file name and attributes are set automatically. 
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7.2.3.2 Restoring Configuration 

To restore a configuration 
1. Click the Administration Backup sub-tab. The following Backup screen appears. 

 
2. The Backup/Restore pane appears. The pane lists the currently backed up files 

and provides backup and restore options.  

3. Select the file to be restored in the Booster.  

4. Click Restore.  

5. After restore is complete, click Reset. 



PRODUCT MANUAL DEKO4078SD MULTI-CHANNEL SIGNAL BOOSTER DEKOLINK WIRELESS LTD. 

Page 58  Proprietary Data P/N 300SC30031 Rev. 1.2 

 

7.2.4 UPLOADING NEW FILTERS 
The application enables the user to import (and export) external files that define a 
filter assignment map.  

   To upload new filters 
1.  Click the Administration Filter Import sub-tab. The following screen appears. 

 
2.  Click Browse and select the file (filter bank) to be imported. The new filter bank 

overrides the previous existing one. 

3. The previous filter settings are deleted so the user must re-configure the filters 
(see  4.2.3). 

 
  
  
 
 



APPENDIX A: RF CONNECTIONS 
 

The following figure provides a description of the RF connections between the Main 
and Power Amplifier units. 

 

 

Figure 24. RF Connections – Block Diagram 

The following table provides the list of RF cables used for the RF connections. 

 

CABLE 
NO. 

FROM TO LENGTH CABLE 
DEKOLINK P/N DESCRIPTION CONNECTOR 

TYPE (CABLE 
SIDE) 

DESCRIPTION CONNECTOR 
TYPE (CABLE 
SIDE) 

W1 DL800 PRE 
OUTPUT 

SMA MALE R.A DL800 PRE 
INPUT 

SMA MALE R.A 15CM 1579907742 

W2 DL700 PRE 
OUTPUT 

SMA MALE R.A DL700 PRE 
INPUT 

SMA MALE R.A 15CM 1579907742

W3 UL700/800 
PRE OUTPUT 

SMA MALE R.A UL700/800 
PRE INPUT 

SMA MALE R.A 15CM 1579907742

W4 UL700/800 
LNA OUTPUT 

SMA MALE R.A UL700/800 
LNA INPUT 

SMA MALE R.A 30CM CC020C0C30 

W5 DL700 LNA 
OUTPUT 

SMA MALE R.A DL700 LNA 
INPUT 

SMA MALE R.A 30CM CC020C0C30 

W6 DL800 LNA 
OUTPUT 

SMA MALE R.A DL800 LNA 
INPUT 

SMA MALE R.A 30CM CC020C0C30 

Power 
Amplifier 

Main unit 



APPENDIX B: SPECIFICATIONS (@+25°C) 
This appendix provides the electrical, mechanical and environmental specifications of 
the Deko4078SD signal booster.  

Electrical 
Parameter DL UL 
 700MHz Band 800MHz Band 700/800MHz Band 
Frequency Range 769 – 775 MHz 851 – 869 MHz 799 – 805 MHz/806-824 MHz 

Composite Output Power  
(Composite output power is controlled by AGC per channel) 

40dbm 27dbm 

Output Power Per Carrier 
1 Carrier 37dbm 37dbm 27dbm 
2 Carrier 34dbm 34dbm 24dbm 
3 Carrier 32dbm 32dbm 23dbm 

Passband Gain  95 dB 95 dB 
Gain Range 60-95 dB @ 1 dB step 60-95 dB @ 1 dB step 
Passband Ripple ± 1.5 dB max ± 1.5 dB max 
AGC Dynamic Range 30 dB 30 dB 
Filter Bandwidth 12.5 KHz – 4.5 MHz (Programmable) 
Channel Delay 5-100 µsec depending on filter bandwidth, flatness and rejection 
Detach time delay Adjustable  5msec – 1sec 
Attack time delay Max. 5msec 
Channel Setting Resolution 0.5 kHz 

Noise Figure at maximum gain* 4.0 dB*; 15dB @ -10dBm input; 10dB 
@ -20dBm input; 5dB @ -30dBm input 3.0 dB*-for signals below -40dBm 

System Sensitivity for 25KHz channel 
-90dBm for 12dB SINAD 

-90dBm for 10⎯³ BER 
-110dBm for 12dB SINAD 

-106dBm for 10⎯³ BER 
Impedance at antenna port 50 Ohms 
Isolation Input to Output  110 dB 
VSWR 1.5: 1 max 
Out of band interference  -10dBm out of Duplexer Pass band without spec degradation 
Maximum in-band signals -10dBm without spec degradation 
Maximum in-band signals – no damage +4dBm 
Power Supply N+1 redundancy 90 to 260 VAC 
Optional DC supply +24VDC; ±48VDC 
Optional Power supply charger + battery  4 or 8 Hours of back-up time 
Power Consumption <600 watts 
Mechanical (for Indoor) 
Packaging 19" cabinet for 10RU equipment, 20" deep without doors 
Unit Dimensions PS 1 RU, Digital filter 4RU, PA+duplexer 5RU 
Connectors N-Female 
Environmental (for Indoor) 
Operating Temperature -10° C to + 50° C (14  to 122° F) 
Humidity 10-95% Condensed 

 

 



APPENDIX C: CONFIGURATION AND 
MANAGEMENT USING DDF APPLICATION 

This appendix provides the initialization and setup procedures for the Deko4078SD 
signal booster. The procedures are performed through an Ethernet connection 
between the Deko4078SD signal booster and a computer running the Management 
Tool supplied with your Setup CD.  

The commissioning procedure consists of opening a Deko4078SD Management Tool 
session and configuring the signal booster general parameters and required filters for 
the 700 MHz and 800 MHz bands.  

COMMISSIONING THE SIGNAL BOOSTER 
INSTALLING THE DMSB MANAGEMENT TOOL ON THE COMPUTER 

To install the Deko4078SD signal booster Management Tool on your 
Computer 
1. Run the Dekolink CD and double click the RMS650_Setup_ddmmyy.exe 

(where ddmmyy is day/month/year in double digits) file to install the 
Deko4078SD Management Tool SW. The following Install Command dialog 
appears. 

 

Figure 25. Install Command Dialog 

2. Click Install. 

3. Double click the RMS650ddf.exe file from the Dekolink CD to run the program. 

4. Once the program is installed, drag the c-RMS650ddf SW icon onto the 
desktop from the location: c:\\program_files\dekolink\rms650\RMS650DDF 
The SW installation is now complete. 
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OPENING A SESSION  
To open a session to the Deko4078SD signal booster 
1. Interconnect the Main unit and the computer on which the Management 

Application is installed using an RS232 connection. 

Note: The connection is performed separately for the 700DL and 800DL and for the 
700/800UL DDF modules. 

2. Run the Deko4078SD Management Tool SW from the start menu of the 
computer on which it is installed. The following login dialog appears. 

 

Figure 26. Login Dialog 

3. Enter the User Name ‘User’. A password is not required. 
4. Click OK. The DDF (Dekolink Digital Filter) window appears. 

Note: The DL and UL windows are similar. 

 

 

 

Connect 

Appears as 700DL and 800DL or 700/800 
UL depending on the RS232 connection 



PRODUCT MANUAL DEKO4078SD MULTI-CHANNEL SIGNAL BOOSTER DEKOLINK WIRELESS LTD. 
 

P/N 300SC30031 Rev. 1.2 Proprietary Data Page 63 
 

5. Click the Connect button in order to establish a connection between the unit 
and the application. 

6. Provision the system according to the following section. 

CONFIGURING THE BOOSTER PARAMETERS 
The booster parameters are displayed with default values, however these can be 
modified according to site requirements. The following configurable booster 
parameters are displayed in the 700 and 800 band windows: 

• Max Power 
• Max Gain 
• Low and high RSSI threshold levels 
• Output Power Threshold 

To configure the signal booster parameters 
In the 700 and 800 band windows, define the configurable parameters (listed above) 
according to site requirements and click the Send Parameters button at the bottom 
of the window. The status of this operation is shown in the Status bar. 

Note: The modified parameter values will appear in red until the Send Parameters button 
is clicked. After the parameters have been sent and written on to the DMSB unit, the 
values are shown in black. 

 

 
The measured values of the unit are displayed in the RSSI, System Gain, Digital Gain 
and Measured Output Power columns. These are read-only parameters. 

Send 
Parameters 

Status Bar
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CONFIGURING THE CHANNELS 
This section describes how to configure the channels for the 700 and 800 bands. The 
application enables defining up to a total of 24 channels (displayed in groups of 6) 
for both the 700 and 800 bands. The channel configuration consists of selecting the 
required channels for each band and defining their filters (the same family of filters 
must be selected for each group of channels). The available channels and required 
filters are accessed from the 700 and 800 Window tabs. 

 

To configure the required channels 
1.  Enable the required channels (up to 24 for both bands) in the Filter Enable 

On/Off column of each of the 700 and 800 band windows.  

Note: The channels are displayed in groups of six. 

2.  Determine the Center Frequency Input. The displayed Center Frequency 
Output will be similar to the displayed input. 

3.  Click CTRL+ A (to enter Advanced mode) and select the required filter type in 
the Filter Description Type column. 

 

 

Array of up
to 24

configurable
channels
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Note: Only one family of filters can be defined for the selected channels in each 
group. Note that when a family is defined, all the channels (6) in the group are 
assigned the same family automatically.  

The filter type parameters include the following: 

• Filter family 
• Rejection 
• Bandwidth 
• Delay 

4.  Click the Show button to view a graphic display of the selected filter. 

5.  Verify the RSSI threshold levels. Modify if necessary according to site 
requirements. 

6.  Click Send Parameters. 

List of filters



NAVIGATING THE SIGNAL BOOSTER MANAGEMENT TOOL 
This chapter describes how to navigate the DMSB signal booster Management Tool 
application and the available functions. 

ACCESS LEVELS  
The enabled parameters displayed by the application depend on the access mode: 
User or Advanced. The default access mode is User. While in the User level the 
functions reserved for Advanced users are disabled (fields are grayed) and are 
displayed for informational purposes only.  

The User and Advanced access modes are defined as follows: 

• User – Default or press CTRL + U (from Advanced mode) 
• Advanced – Press CTRL + A 
• Technician – Press CTRL+ T 

Note: It is specified when the application requires entering the Advanced mode to define 
a specific parameter. 

MAIN WINDOW 
The main window is used for configuring the required channels (up to 24 for both 
bands). The signal booster identification information is displayed at the top part of 
the window. 

The main window consists of the following tabs: 

• 700DL/800DL or 700/800 UL – Displays the available 700 MHz and 800 
MHz band channels for the user to select from in addition to the required 
filters. Also, displays center frequency (input equals output) and RSSI levels. 

• Global – Displays the unit information (i.e serial number, SW version, etc.). 
• Routing – Includes the FPGA Routing for transmitting CW in Test mode. 
• Setup – N/A - for Dekolink Technicians only. 
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Note: Grayed fields are not active.  

Indicates 
whether  in DL 
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700DL/800DL and 700/800UL Channels 

Note: The UL and DL windows are similar, however they are accessed separately as 
described in the Opening a Session section of this appendix. 

The 700 and 800 channel tabs display an array of up to 24 available channels (for 
both bands) for the user to select in addition to the required corresponding filters. 
The available channels to select from are displayed in groups of six (i.e Ch1- Ch6; 
Ch7-Ch12). The displayed input center frequency is equal to the displayed output 
center frequency. The following figure shows the 700DL screen (the 800DL tab is 
similar). 

 

 
 

The following table provides a description of the configurable and non-configurable 
filter parameters displayed in this tab. 

 PARAMETER DESCRIPTION 

CONFIGURABLE FILTER ENABLE 
ON/OFF 

ENABLES/ DISABLES THE ACTIVE CHANNELS 

AGC ENABLES/DISABLES AUTOMATIC GAIN CONTROL 
CENTER 
FREQUENCY INPUT 

DISPLAYS THE CENTER FREQUENCY INPUT FOR THE 
CORRESPONDING CHANNEL OR FILTER. THE VALUE 
SHALL BE CONSISTENT WITH THE FREQUENCY BANDS 
OF THE DMSB AS LISTED IN APPENDIX B: 
SPECIFICATIONS. 

CENTER 
FREQUENCY 

DISPLAYS THE CENTER FREQUENCY OUTPUT (EQUALS 
TO THE INPUT CENTER FREQUENCY – UNLESS IN 
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OUTPUT FREQUENCY SHIFT MODE SEE SECTION  0) 
FILTER 
DESCRIPTION TYPE

DETERMINES THE FILTER TYPE FOR THIS CHANNEL, BY 
CLICKING IN THE COMBO BOX AND SELECTING A FILTER 

FILTER DRAWING CONSISTS OF THE SHOW BUTTON THAT PROVIDES A 
GRAPHIC DISPLAY OF THE FILTER CHARACTERISTICS 
(SEE  0). 

OUTPUT POWER 
LEVEL 

DETERMINES THE OUTPUT POWER FOR THE CHANNEL 
SIGNAL – THIS VALUE SHALL BE EQUAL FOR THE ACTIVE 
FILTER AND ITS MONITORING COUNTERPART 

RSSI LEVELS DETERMINES THE RSSI THRESHOLD VALUES FOR THE 
SELECTED ACTIVE CHANNELS. THESE VALUES DEFINE 
THE OUTPUT POWER LIMITS OF THE CHANNEL PATH. 

NON-
CONFIGURABLE 

MEASUREMENT 
OUTPUT POWER 

DISPLAYS THE MEASURED COMPOSITE OUTPUT POWER 

SYSTEM GAIN  DISPLAYS THE CURRENT SYSTEM GAIN MEASUREMENT 
RSSI 
MEASUREMENT 

DISPLAYS THE CURRENT RSSI MEASUREMENT  

DIGITAL GAIN 
MEASUREMENT 

DISPLAYS THE DIGITAL GAIN FOR EACH CHANNEL 

Routing 
The Routing tab includes the FPGA Route parameter that enables transmitting the 
CW  and ID Tone in Test mode (see  0). 

The following figure shows the Routing tab. 

 

 

Figure 27.Routing Tab 

FPGA Route
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Global 
The Global tab includes a display of the Deko4078SD signal booster information, the 
Frequency Shift Mode enable/disable checkbox (not relevant) and the system PL 
Mode parameters. The signal booster information displayed corresponds to the 
connected Deko4078SD signal booster and the System PL Mode parameters are 
displayed with the default values. The following figure shows the Global tab. 

 

Figure 28. Global Tab 

The Global screen displays the following: 

DMSB signal booster Information  

• Part Number  
• Serial Number  
• Software version  
• Hardware version  
• SNAP ID – SNAP protocol identification number  
• Technician password – N/A  

DMSB signal booster Information 

• PL Detect Mode 
• PL Timer (msec) 
• ID Tone Period (msec)  - Used for ID Tone definition not relevant) 
• ID Tone Freq [Hz] 
• ID Tone Volume 
• Timeout Timer Period (min.) – Closes each Tx channel after it has been in use 

longer than the defined time limit. 
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DMSB MT OPERATIONS 
FREQUENCY SHIFT 

Frequency shift enables setting an output frequency that is different from the input 
frequency. 

To enable the frequency shift option 
1.  Access the Global tab of the DDF Window. 

2.  Click CTRL+A to enter Advanced mode. 

3.  Enable the Frequency Shift checkbox. See following figure. 

 

Figure 29. Frequency Shift Mode 

4.  Continue to the Channel (700DL/800DL) tab to determine the Center Frequency 
Input and Output. 

Frequency Shift 
checkbox 
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VIEWING GRAPHIC DISPLAY OF FILTER  
The Filter screens are shown by selecting a Filter Type in one of the window tabs 
and clicking the corresponding Show button.  

The Filter screen includes several displays (Select Picture button, at bottom) that 
enable viewing the filter properties and characteristics to ensure a proper selection of 
the filter. 

 

 
 

Show button

Filter display
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FPGA ROUTE 
The Deko4078SD MT application enables further narrowing down the signal passed 
for each channel. This option is performed via the FPGA Route parameter, which 
processes the signal via the DSPA. 

 

 
 

To define the FPGA Route Parameter 
1.  Access the Routing tab of the DDF window. 

2.  Click CTRL+A to access the Advanced mode. 

3.  Click the FPGA Route parameter to be defined corresponding to required channel 
and select one of the following options from the drop-down list: 

• Normal – Signal is passed “as is” 
• CW – Booster can be used to generate the signal  
• Zero – No signal 

4. Click the Send Parameters button. 

FPGA Route
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VIEWING ONLINE DMSB SIGNAL BOOSTER PARAMETERS 
To view current Deko4078SD signal booster Parameters 
After a connection has been established between the computer and the signal 
booster click the Get button, located at the bottom of the 700DL/800DL or  
UL700/800 shown below.  

 

SAVING / LOADING CONFIGURATIONS  
The DMSB definition process includes the option to save the current configuration, 
and on the opposite to load a previous configuration.   

The configuration files (.cfg) are stored in the DMSB in an internal directory.  

To save/load a configuration 
1.  Press CTRL+ T to enter the Technical Mode. 

2.  Click on the File menu form the menu toolbar and select Load Configuration or 
Save Configuration, depending on the required action. 

3.  Select (for Load) or name (for Save) a file and proceed as for any Windows file.

Get Parameters



APPENDIX D: MUTING POWER AMPLIFIERS 
AND PERFORMING OUTPUT ATTENUATION 
PROCEUDRES 

This section provides a description on how to manually mute a domain power 
amplifier (700DL, 800DL, or UL) and to attenuate the output power via the Dekolink-
NMS Web GUI application. 

OPENING A SESSION 
1.  Interconnect the Deko4078SD Signal Booster Main unit and the computer using 

an RS232 connection. 

2.  Configure the computer network parameters (see  4.1.2). 

3.  Login (see  4.1.3). The following screen appears: 

 

Tree pane listing
the monitor and
UD (Up-Down)

cards
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MUTING A POWER AMPLIFIER 
To mute a power amplifier 
1.  Click the Mon Pamp Drawer in the left-hand tree pane. 

  

 
2.  The Mute operation is performed through the Pamp 1 mute, Pamp 2 mute, 

Pamp 3 mute and Pamp 4 mute parameters, shown above. 

3.  Click Send. 

Send 
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OUTPUT ATTENUATION 
To attenuate the DSA output 
1.  Click a UD item (Uplink or Downlink) in the left-hand tree pane. 

 

 
2.  Set the Attenuator Control parameter to 1 and set the DSA parameters as 

required. 

3.  Click Send. 

Attenuator Control 
parameter 

Send 



APPENDIX E: DEKOLINK WIRELESS 
LIMITED WARRANTY 
Dekolink Wireless LTD. (“Dekolink”), manufacturer of this product  
(the “Product”) warrants to the original purchaser (“Purchaser”) that the Product is free from defects 
in materials and workmanship for a term that ends on the earlier of twelve (12) months from the 
date of activation of the Product or fifteen (15) months from the date of shipment of the Product by 
Dekolink. The obligations of Dekolink under this warranty shall be limited solely to the repair or 
exchange or giving credit for, at the option of Dekolink, any Product that may prove defective in 
accordance with evidence satisfactory to Dekolink. Any repair or replacement of the Product by 
Dekolink shall not extend the original warranty period. This warranty is exclusive to the original 
Purchaser and is not assignable. 
This warranty applies only upon the condition that the Product has been installed, maintained and 
operated under conditions of normal use. The provisions of this warranty shall not apply if, in 
Dekolink’s judgment, the Product has been subject to misuse or neglect, damaged in an accident or 
by act of vandalism, or repaired or altered in any way that adversely affects its performance or 
reliability. 
To obtain warranty service, Purchaser may, upon the prior written authorization of Dekolink or its 
authorized service representative, return the defective Product to Dekolinks authorized service 
center. All shipping and insurance charges are the sole responsibility of Purchaser and are not 
included in this warranty. 
Dekolink expressly excludes and disclaims all other warranties, including but not limited to any 
warranties of merchantability or fitness for a particular purpose.   
Dekolink shall in no event be liable for any special, indirect, incidental, consequential or punitive 
damages or for loss, damage, or expense, including loss of use, profits, revenue, or goodwill, directly 
or indirectly arising from purchaser’s use or inability to use the merchandise, or for loss or 
destruction of other property or from any other cause, even if Dekolink has been advised of the 
possibility of such damage. Some states do not allow the exclusion or limitation of incidental or 
consequential damages so these limitations may not apply under certain circumstances. The liability 
of Dekolink shall in no event exceed an amount equivalent to the purchase price paid by the 
purchaser for the defective product. This warranty shall not be extended, altered or varied except by 
a written instrument duly signed by Dekolink. 


